
Computer Survival Skills in C1151 Laboratory 
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v.11.10 

 
The objective of this experiment is to introduce you to computer skills and applications that will let you acquire and 
process data collected in chemistry experiments.  Keep these instructions and bring them to each lab session as they will 
be used throughout the semester. 
 
Network Login: (only one person can be logged in at a time) 

• On the Novell Login screen, enter your MCTC ID in the username field and your PIN for the password. 
• Make sure that the “Workstation Only” checkbox is NOT checked. 
• Click OK  

 
Desktop Description 

• These C1151 applications appear on the desktop: 
o Logger Pro  … data acquisition 
o Internet Explorer … browser 
o Excel   … spreadsheet 
o Word   … word processing 
o Chem 3D Ultra 3.0 … molecular modeling 

• Double click the appropriate icon to activate the application. 
• Switch between applications by clicking on their button in the lower application tray (below). 

 
 

Windows survival skill: 
Do you have a computer/application related question?  “RIGHT CLICK” on the object you have a question about. A 

contextual menu of options will appear that will likely answer your questions or give you additional options. 

 
 

Typical Data Acquisition Procedure 
 

1. Activate LoggerPro and collect data in table format 
 

2. Select and Copy data in LoggerPro table. 
 

3. Open Microsoft Excel and Paste data into Excel spreadsheet 
 

4. Save the Excel spreadsheet (it contains valuable data!).  Saving options include: 
a. USB flash drive (highly recommended).  128MB is more than plenty and they’re cheap. 
b. Saving the data to the /temp directory on the C:\ drive and emailing it to yourself 
c. Saving the data to your H:\ drive (you can access this from home) 
d. Save only Excel and Word files.  Don’t save LoggerPro files. 

 
5. Manipulate your data  in Excel   

a. Construct graphs 
b. Perform calculations 
c. Look for patterns and relationships among data  
d. Print graph and submit with experimental data sheet. 

 
 

 
Windows survival skill:   

Save your files often to avoid lost data!!! 

 



Today’s Experiment: Computer Setup  
 

1. Obtain a laptop computer and charger. Connect the charger to a 
wall outlet and the laptop computer. 

2. Plug in the Lab-Pro interface box power supply into an available 
outlet and the interface. 

3. Plug the temperature probe into the Channel 1 (CH 1) position of 
the Lab-Pro Interface (Figure at right).  

4. Connect the Logger Pro interface box to the computer using the 
USB cable. 

5. Activate the LoggerPro software application. 
6. Check to be sure the “Collect” button is green.  If it is not, check 

the interface box power cord and the USB cable connections. 
7. Open the “Computer Survival” LoggerPro file (You must be properly logged into the network to open this file) 

 
Windows survival skill: 

You can alternate between full screen and window mode by double clicking  
on the bar at the top of an open application. 

 
Today’s Experiment: Procedure  
 

1. Fill a 250 mL beaker ¾ full with hot tap water. 
 

2. Hold the temperature probe in the hot water.  Make sure it does not touch the bottom or sides of the beaker 
when collecting data. 
 

3. Click the "Collect" button (Green button at the top right-hand corner) on the LoggerPro window to start data 
acquisition.  LoggerPro will start recording the data.   
 

4. Measure the temperature of the hot water for a period of 2 minutes; STIR THE WATER WITH THE 
TEMPERATURE PROBE AT ALL TIMES using the temperature probe. 
 

5. Continue to stir, acquire data  and have your partner quickly add ~1/2 cup of ice.    
 

6. Continue collecting data for an additional 3 minutes after the addition of ice. 
 

7. Click the red "Stop" button in the top right corner when you have finished.   
     DO NOT EXIT THE LOGGERPRO PROGRAM!! 
 

8. Note:  You will see a curve being plotted by the LoggerPro.  The x- and y-axis scales and range can be modified 
to fit the curve on the screen (Right click on a number on the axis and choose Autoscale from the drop down 
menu). 
 

9. Select all the data in the LoggerPro data table: 
a. Click and drag over the data in the table or better…  
b. Click the word “latest” at the top of the table to select the entire data  
c. Click edit and copy. 

 
10.  Minimize the LoggerPro application. 

 
11.  Activate Microsoft Excel then click in the top left cell and then Click on Edit→Paste  

 
12. Save the Excel spreadsheet on the network H:/ drive  

a. Click of File→Save  
b. Choose H:/ drive (this will be the one with the student ID number next to it) 
c. Give an appropriate name (Use the date, experiment number, your names, etc in the file name)  before 

saving the file 
 



 
Windows survival skill: 

Use Ctrl-x, Ctrl-c and Ctrl-v as quick and easy alternatives to Cut, Copy and Paste.   
The shortcuts will often work even when the usual editing functions can’t be seen on the screen. 

 
Data Analysis: Microsoft Excel Operations (Excel 2007) 
 
Inserting Column Titles 

1. Select the first horizontal line of data by RIGHT clicking on the number “1” at the 
far left 
 

2. Select “Insert” from the popup menu that appears. A blank line should be inserted 
above your data thus shifting your data downward one line. 
 

3. Click on the cell above the first data column and enter the words “Time (sec)”.  
Repeat the procedure for the second column using “Temperature (°C).   

 
 
 
Calculations: Creating a formula  

You will now create a formula that will convert all Celsius temperature measurements to Fahrenheit. 
 

1. Click on the cell C2 (an empty cell next to the first temperature reading) 
 

2. Formula entry:  
a. Enter =     (all equations begin with an equals sign) 

 
b. Then enter:  1.8*B2+32  (This formula, TF  = 1.8 × TC  + 32,   

converts the temperature in cell B2 from Celsius into Fahrenheit) 
 

c. Press Enter 
 

d. Click on cell C2 
 

e. Now click editàcopy   … to copy the contents of cell C2 which will now 
appear with a dotted line around it. 
 

f. Select the entire range of cells in the C column, i.e., drag through until the 
last data cell  
        (…or click on the top cell and then shift click on the bottom cell). 
 
Important: DON’T select entire columns by  
                   clicking on their headers (letters at top).   
 

g. Click editàpaste  
 

h. The cells which you paste automatically use the next entry in the B column  
(…i.e. B2, B3 etc.) and converts it into Fahrenheit degrees in the C column. 
 

3. Label the calculated column Temperature (°F)   
 



Creating a line graph 
In this exercise you will select two columns of data and use them to construct a graph.  The first column of data 
is the “independent” variable (Time) and is what is used for the “X” axis.  Similarly, the other column of data is 
the “dependent” variable (Temperature: oF) and corresponds to “Y” axis values. 
 

1. Select the two columns, time and Temp oF. (Click and drag over the first column. Then “Ctrl” click and drag over 
the Fahrenheit column.) 

 
2. Click on the “Insert” tab ….  Scatter Plot (↓ 

arrow for more options)… “Scatter with 
Straight Lines and Markers”  
  
 

3. A graph will now appear on your 
spreadsheet  
 

4. Click once on the graph to select it  
 

5. Click on the “Layout” tab                   
→ “Axis titles” (↓ arrow for more options)                   
→ “Primary Horizontal Axis Title”                   
→ “Title Below Axis” 
                 →  Enter “Time (sec)” as the X axis title 
  
  
  
  
  
  
  
  
  
  
 

6. Use a similar recipe to add the title for the Y axis. 
 
7. Click on the graph title edit it.  Type in “Computer Survival: Temperature vs. Time,  your name and today’s date” 

as the title. 
 

8. Click on the graph legend and then press the “delete” key on your keyboard to remove the legend.  Adjust your 
graph axis to minimize the amount of wasted space (right click on the axis labels, then “format axis”):  

  
  
 
 
 
 
 
 
 



Graph Modification 
 

Your graph should look similar to the one shown at right.  
Use the textbox tool (Click on graph→Layout Tab→Textbox 
tool) to create labels for each of the three graph regions. 
  
You can also remove the “gridlines” from your graph by right 
clicking on a single gridline, selecting “format gridlines” from 
the menu and then changing their color to white.   
 
 
 
 
 
 

Windows survival skill:  
 

Many graph options can be accessed by directly RIGHT clicking on the feature you want to change.   
For example, to turn off the data markers and leave only the line that connects them, right click on the dotted line, 

and select “Format Data Series”. 
 

 
Identifying Data Points 

 
 
You can easily identify data points on your graph by 
clicking on the data point.  
 
In the example at right, the cursor has been 
positioned over a data point corresponding to 
time=147 seconds and Temperature=62.9366°F. 
 
Using the mouse in this way, determine the X,Y 
points that define the beginnings and endings of 
regions 1 and 3 of your graph. Write these 
ranges/points down in your notebook.   
 
Be careful to identify points where the line is 
perfectly straight and NOT curved. 
 

1 



Trendline Analysis  
 
The word “Trendline” is Microsoft Excel’s term for straight line analysis.  By specifying a particular range of data, you can 
instruct Excel to draw the best straight line through the range of data.  Furthermore, Excel can also display the equation 
of the best straight line in y = mx + b form (slope intercept form). 
 
We will be creating trendlines for regions 1 and 3 of the graphs you’ve created.  In these examples, the slope of the line 
is a number that tells us the rate of heating or cooling (i.e. degrees Celsius temperature change PER second.    
You can create a Trendline for region 1 as follows:  
 

1. Create a new data series 
a. Right click on the graph and choose the “Select Data” 

option 
 
 
 
 
 
 
 
 
 

b. In the “Select Data Source” window that opens, Click on 
the “Add” button 
 
 
 
 
 
 
 
 
 
 
 

c.  When the “Edit Series” window opens, enter the name of 
the new series as “Region 1: Cooling Water”  
 
 
 
 
 
 
 
 
 
 

d. Now click on the button to the right of the “Series X 
values” box.  This will return you to the spread 
sheet.  
 

e. Use the information you recorded earlier as a guide 
and select the time (X) values corresponding to 
range 1. 
 
 
 

f. Click on the button in the narrow window (figure below) 
to accept your selection. 



 
 

g. Repeat steps d, e, and f for the temperature 
values “Y”.  Be careful to only select 
temperature values that are within the range of 
Region 1 of your graph. 
 
 
 
Click “OK” on the Edit Series window (See 
right) 
 
 
 
 
 
 
 
 
 
 

h. Click “OK” in the Select Data Source window.  
 
 
 
 
 
 
 
 
 
 
 
   

i. Your  graph should look like the one at right.  The 
new series will be highlighted in a different color.   
 
 
 
 
 
 
 
 
 
 

 
 

2. Right click on the red highlighted data series and 
choose the “Add Trendline” option. 
 

 
 
 
 
 



 
3. In the “Format Trendline” window opens, make the following changes: 

 
a. Trend/Regression Type:  Linear (default) 

 
b. Display Equation on Chart (Checked) 

 
c. Display R-squared value on Chart (Checked) 

 
d. Click “Close” 

 
 
 
 
 
 
 
 
 
 
 

4. The trendline equation and R-Squared value will now be 
displayed on your graph.  Drag this box to a clear region 
of the graph but not far from region 1 (where it belongs).  
 
 
 
 
 
 
 
 
 
 
 

5. Frequently, we’ll use the trendline equation as we perform calculations.  
For this reason, it is important to display a trendline equation that has 
more than the default number of significant figures. 
 
 
Increase the number of decimal places displayed by the trendline: 
 
 

a. Right click on the trendline box 
b. Choose “Format Trendline Label” 
c. Click on “Number” in the list of display formats  
d. Enter “8” in the Decimal Places window 
e. Click OK 

 
 

6. Repeat the above recipe for region 3 of the graph. 
 



Trendline analysis: Continued  
 
The equations you generate will be in the form of   
 

y = mx + b 
 
 
However, in our experiment, didn’t use  X’s and Y’s, rather 
we have “Time” and “Temperature”.   
 
Thus, if you obtain an equation that looks like this: 
 
  y = -0.01793525x + 100.5470 
 
              It really means: 
      
     Temp = -0.01793525 × Time + 100.5470 
 
The slope (-0.01793525) is negative because the temperature is DROPPING at a rate of 0.0179 degrees Celsius per 
second (rise/run = °F/sec for units). 
 
 
 
 
Printing:  There is no printer in the laboratory.  You will have to properly save your files and print them out in one of 

the student computer labs. 
 
File transfer 

 
• USB: Flash Drive.  The cost of memory has decreased dramatically.  4 GB USB flash drives currently cost less 

than $10.  
 

• Email attachments:  E-mail only Excel and Word files that you created.   
Don’t email the LoggerPro files since no other computers will recognize these files! 

o Create a FREE email account:  
§ Hotmail (www.hotmail.com) 
§ Yahoo (www.yahoo.com) 
§ Google (www.google.com).   

 
• H:/ drive.  When logged into the campus network, you will have access to your “H” drive.   

 
Finished?  …not quite 
 

1. Don’t leave lab today without knowing you have a secure, intact MS Excel file!!!  
2. Be sure to  SHUT DOWN the computer and put away all Logger pro accessories, the laptop charger and the 

laptop computer in their correct locations. 
3. Leave your glassware upside down, on a paper towel on the benchtop.  The next lab section will re-use your 

equipment. 
4. Wash the benchtop with a wet SPONGE 
5. Have your instructor sign your data sheet before you leave.  You will not receive full credit without their 

signature. 



C1151 Data Sheet        Name______________________ 
Computer Survival Skills      Date of Exp. ________________  
Instructor Initials_____      Lab Section   ________________ 
 
Your individual experimental report will be due at the beginning of class next week.  
 
Answer the following questions. 

• Answers must be readable and make sense for credit. 
• Copied answers will result in all involved students receiving a zero score 

 
1. Region 1 of the graph will have a negative slope telling us that the temperature is dropping.   

a. Where is hot water’s heat energy going?   
_________________________________________________________________________________________ 
_________________________________________________________________________________________ 
b. If left to cool for a long time, what will be the final temperature? 
_________________________________________________________________________________________ 
_________________________________________________________________________________________ 
 

2. a. What are the slope values (include sign) for regions 1 & 3.  
_________________________________________________________________________________________ 
 
b. Explain why these slopes are different. 
________________________________________________________________________________________ 
__________________________________________________________________________________________ 
 

3. How will the slope values of regions #1 and #3 change if the experiment is conducted in an insulated Styrofoam 
cup instead of a beaker? Why? (The word “heat” should appear in your answer)? 
_________________________________________________________________________________________ 
_________________________________________________________________________________________ 
_________________________________________________________________________________________ 
 

4. How would the temperature graphs you recorded be different if you mixed the liquid very slowly with the 
temperature probe? 
_________________________________________________________________________________________ 
_________________________________________________________________________________________ 
_________________________________________________________________________________________ 
_________________________________________________________________________________________ 
 
 

5. In an experiment where a mass in cg (Y) is graphed vs. temperature in Kelvin (X) a straight line is observed.  
What are the units of the slope of a straight line on this graph? 

      _________________________________________________________________________________________ 
_________________________________________________________________________________________ 

        
        
 
Staple a printout of your Excel graph to report.   
               (Hint:  First click on the graph to select it and then print.  This avoids printing out the data table) 
 

Your graph (Temperature (oF) vs Time) should include:  
 

• Adjusted axis limits.  Make adjustments to the graph scales to fill the graph with your data. 
• Correct and complete axis titles 
• Correct and complete graph title (Experimental name, your name and date of experiment) 
• Legible trendline equations for regions 1 and 3 in appropriate locations with the correct SF. 


